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1 Introduction to TotalDeploy   

This chapter gives a general idea of how an IT department can face various real life challenges 

using the Farstone TotalDeploy . 

1.1 Overview 

1.1.1 What is TotalDeploy   
TotalDeploy is a flexible, efficient software solution that is used for deployment of a fully 

configured operating system (with or without application software and any other data) to 

multiple computers. 

Because TotalDeploy uses disk imaging technology, it is ideal for rapid bare-metal installations 

and flexible centralized provisioning. 

1.1.2 Who needs TotalDeploy ? 
TotalDeploy is primarily designed to be used by: 

Small and medium-sized businesses: 

 IT service providers 

 Hardware retailers 

 IT departments of larger corporations 

 Schools and universities 

 Net bars or internet cafes 

 Research & development labs and software testing labs 

The rapid deployment features of TotalDeploy can help automate the tasks of the IT 

department in large enterprise environments. 

1.1.3 TotalDeploy infrastructure 
Components of the Farstone infrastructure are installed on Windows computers. Centralized 

deployment and managing of the Farstone infrastructure is performed using the TotalDeploy 



Console. 

A reference image can be taken either in Windows by Total Backup Recovery Pro/Ser or in 

Pre-OS environment by Total Backup Recovery Express. Under Pre-OS, GUI mode is provided.  

Deployment is performed in Farstone Pre-OS environment. 

 

1.2 What you can do with TotalDeploy   

1.2.1 Take an image of the master system 
First, you create the desired system configuration and save the image of the system hard disk 

on a network share, detachable media, or removable media. The image is a file that contains 

the system in a packaged form. 

Scenarios: 
1. Company departments such as accounting, sales, or technical support usually use a 

fixed set of applications for daily work. Capture an entire library of images and deploy 

them to new hardware without having to manually configure the operating system and 

applications. 

2. The administrator might need to deploy a standard configuration (included in the 

library) onto various hardware. The integrated Farstone Universal Restore option 

can configure Windows system drivers so that Windows is able to boot on dissimilar 

hardware. Without this option, the  motherboard, processors, and mass storage 

devices of the imaged and targeted hardware must be identical.  

3.  Export Backup Agent ISO from “Export Backup Agent” from the Tool tab page of main       

UI. Having burned the ISO to a CD/DVD, you boot the master system(also called source 



computer) with the CD/DVD. After booting into Farstone Pre-OS, please backup your 

system partition/whole harddisk(s) to an Image (named Master Image). You can save the 

Image to a preferred location, such as a network shared folder residing in your console 

computer. 

 

1.2.2 Manual deployment   
Boot the target computers (the computers to deploy to) into Pre-OS environment using 

Farstone bootable media (such as Total Backup Recovery Express) or PXE (Preboot eXecution 

Environment) Server. Set up and save parameters of the deployment operation (the 
deployment template.) 

Launch the deployment. The program multicasts the image to the computers you specified and 

deploys the system on their hard disks. DNS names, domain or workgroup membership, TCP/IP 

settings, user accounts and security identifiers are assigned on the fly according to the settings 

you made. 

Once the deployment is completed, the computers boot up from their hard disks. The program 

can shut down or restart the computers according to the settings you made. Sometimes you 

will have to complete configuration of devices; otherwise, the computers are ready to work. 

(Activation of the operating system is needed.) 

Note: If you have set PXE server, make sure to stop PXE-related services after your deployment 

job is completed to avoid all clients’ booting into Pre-OS environment again. 

1.2.3 Template Deployment 
After each manual deployment, users can choose to save their deployment template (which 

may be reused). When templates are reused, the target computers are the current connected 

computers instead of the computers that were previously connected. 

1.3 Supported operating systems 

Farstone TotalDeploy suite provides full-featured imaging and deployment for the following 

operating systems. 

                      OS Deployment Universal 

Restore 

License 

type* 

MS Windows 7(x86, x64) Yes Yes S 

MS Windows Server 2008 Yes Yes S 

MS Windows Server 2003 Service Pack 2 (x86, x64) Yes Yes S 

MS Windows Server 2003 R2 (x86, x64) Yes Yes S 

MS Windows Small Business Server 2003 Yes Yes S 

MS Windows Storage Server 2003 R2 Yes Yes S 

MS Windows Server 2003 x64 Editions Yes Yes S 

MS Windows Vista Home Basic (x86, x64) Yes Yes WS 
 

MS Windows Vista Business (x86, x64) Yes Yes WS 
 



MS Windows Vista Home Premium (x86, x64) Yes Yes WS 
 

MS Windows Vista Ultimate (x86, x64) Yes Yes WS 
 

MS Windows XP Home Yes Yes WS 
 

MS Windows XP Professional Yes Yes WS 
 

MS Windows XP Professional x64 Edition Yes Yes WS 
 

MS Windows XP Professional SP2 Yes Yes WS 
 

* - S – server license, WS – workstation license. 

1.4 License policy 

Farstone TotalDeploy licensing is based on the number of deployed and/or managed computers 

(servers or workstations.) For example, to deploy a system on 100 computers, you need 100 

deployment licenses. No additional licenses are required to manage the deployed computers or 

to redeploy any of them.  

1.4.1 Server and workstation licenses 
Farstone TotalDeploy has two types of licenses:  

 A license for the server product is needed to deploy a server operating system or install 

the Deploy Agent on a server operating system.  

 A license for the workstation product is needed to deploy a workstation operating 

system or install the Deploy Agent on a workstation operating system. A workstation 

license is needed to deploy a disk or partition that does not contain an operating 

system, if the target computer has not been assigned a license before. 

 

If Farstone TotalDeploy fails to identify the type of operating system, the operating system is 

considered as a workstation OS. 

A server license may be used instead of a workstation license automatically or through a 

prompt. 

2 Installation 

2.1 System requirements 

The Farstone TotalDeploy components can be installed on computers running the following 

operating systems: 

                               OS License 

MS Windows Server 2008 (TBD) S 



MS Windows Server 2003 Service Pack 2 (x86, x64) S 

MS Windows Server 2003 R2 (x86, x64) S 

MS Windows Small Business Server 2003 S 

MS Windows Storage Server 2003 R2 S 

MS Windows Server 2003 x64 Editions S 

MS Windows Vista Home Basic (x86, x64) WS 

MS Windows Vista Home Premium (x86, x64) WS 

MS Windows Vista Business (x86, x64) WS 

MS Windows Vista Ultimate (x86, x64) WS 

MS Windows XP Home WS 

MS Windows XP Professional WS 

MS Windows XP Professional x64 Edition WS 

MS Windows XP Professional SP2 WS 

* - S – server license, WS – workstation license. 

Tip: To assure deployment efficiency, we recommend using a server with up-to-date 

configuration to install Console module. The Master Image is saved in that server where 

Console resides in, which will minimize use of network capacity. 

2.2 Used ports and IP addresses 

The Farstone TotalDeploy Console use the following ports and IP addresses for remote 
operation： 

- UDP port: 5002, 5004 

- TCP port: 5001, 5003 

- IPv4 multicast address: 239.254.1.1 and 239.254.1.2 

 

2.3 General steps of installation   

  Farstone TotalDeploy Console is an administrative tool that is used for remote access to 

Farstone TotalDeploy Agent. Install Farstone TotalDeploy Console on any networked computer 

from which you prefer to operate. 

Before installation, please make sure the Console-residing computer and all target clients 

must be on the same subnet.  

To install Farstone TotalDeploy Console: 

1. Run the Farstone TotalDeploy Console setup program. 

2. Follow the Install Wizard instructions on the screen. 

3. Input Serial number and activate it. 



 

3 General steps for Deployment 

There are two standard deployment methods:  

1. Deploy by PXE booting 

2. Deploy by bootable media.  

3.1 Deployment by PXE 

Follow these steps: 

1. Start Deploy Console, and Export PXE Files from Tool tab page. 

2. Configure and start your PXE Server. 

3. Enter all target computers’ BIOS, and set their “Boot from LAN” as 1st priority. 

4. Restart all target computers. To make sure all clients are booted by PXE successfully, 

do not restart computers at the same time, especially when there are many target 

computers. 

5. Deploy the master image to all the target computers. 

6. After all computers are deployed, stop PXE-related applications to avoid the targeted 

computers to reboot into Farstone pre-OS again.  

 

(Please refer to Appendix 1 for detailed steps.) 

3.2 Deployment by Bootable Media 

Follow these steps： 

1. Start the TotalDeploy Console and Export Client Agent from the Tool tab page. (You 

may also retrieve the ISO file from the installation package.) Use this to make your 

bootable media. 

2. Start the TotalDeploy Console if it has not yet been started. 

3. Boot all target computers into Farstone Pre-OS environment with the bootable media. 

4. Deploy the master image to all target computers. 

 

Tip: If you use USB hard drives as the bootable media, first use TBR/Ser software to make the 

bootable USB, and then export PXE files. The exported files with extension of “wim” should 

substitute the files whose extended name is “wim” in the USB hard drive. 

 

 



4 Using TotalDeploy Console 

4.1 Main UI 

In the Main console after starting TotalDeploy Console, you will see this in the Main UI: 

 
In the Main UI, you can create a new deployment template or load an existing template from 

the “Operations page”. You may also check master image, view deployment logs, export PXE 

bootable files, and set template-stored path from the “Tools page”. 

  

Before starting deployment, all target computers must be booted. Please refer to Chapter 3.1 

or 3.2 for how to boot target computers by PXE or by bootable media for details. 

 

If all target computers are ready, click “Deployment solution”, and you will see the screen 

below. All connected computers will be displayed in the computer list. These computers are 

available for your later deployment operations. 



 

5 Taking an image 

To be able to deploy a system, you must create the desired system configuration and save the 

image of the system hard disk on a network share, detachable media, or removable media. 

Farstone TotalDeploy also supports images (including password protected images) taken with 

the Total Backup Recovery (TBR) product series. 

5.1 Preparation of the master OS 

It is very common to prepare a master operating system with the Microsoft System Preparation 

Tool (Sysprep) before creating the system image. Sysprep is designed for corporate system 

administrators, OEMs, and others who need to deploy and automatically configure operating 

systems on multiple computers. 

After a Sysprep operating system is deployed, Sysprep generates a unique security ID (SID) for 

the new host, initiates Windows mini-setup for plug-and-play devices, applies the computer 

name, domain or workgroup membership and other settings specified in the Sysprep.inf 

answer file. 

You can download Sysprep from www.microsoft.com or extract it from deploy.cab located on 

Windows XP/Server 2003/Server 2008/Vista/Win 7 installation CD. 



We strongly recommend that you read articles about Sysprep and disk duplication in the 

Microsoft Knowledge Base. 

5.2 Online vs. offline imaging 

A master image can be taken: 

- offline, in Pre-OS environment, using Farstone bootable CD/DVD made by “Export 

Backup Agent” from the Tool tab page  or Bootable CD/DVD/USB made by TBR 

Pro/Ser  

-  online, in Windows, using any one of the TBR series product installed on the master 

computer 

Running the agent in Windows is an obvious choice if you plan periodic remote imaging. 

Imaging with the agent does not require the master computer to reboot.  

5.3 Starting offline imaging 

Offline imaging means that the master system is stopped and the master computer boots into 

Farstone Pre-OS environment. 

1. Configure the master system. 

2. Create a bootable CD/DVD with a ISO file exported by “Export Backup Agent” from the 

Tool tab page, or create a bootable USB device by TBR Express or any other TBR Series 

products, 

Or  

Configure PXE Server, and upload PXE files (exported from TBR Series products) to the 

PXE server. Make sure that network booting is enabled on the master computer (see 

“Appendix 1 Setting up a computer to boot from PXE” for details.) 
3. Do one of the following: 

- Boot the master computer into Farstone Pre-OS environment from bootable media 

or 

- Boot the master computer into Farstone Pre-OS environment from the PXE Server. 

4. The Farstone Pre-OS environment establishes network connection to be able to save the 

image on a network share. A dialog box should come up, suggesting that you configure 

the network connection. 

By default, Farstone Pre-OS uses DHCP auto configuration, and applies the default 

network settings automatically on timeout. 

Manual configuration is needed if auto configuration is not possible (no DHCP server on 

the network) or does not succeed. 
 5. Click the “Back up computer(s)” button in the Main UI to backup the system partition 

or all hard disks of the master computer.  



 

5.4 Starting online imaging 

Online imaging means that the master system is imaged live (without rebooting or suspending 

operations). Online imaging can be performed whenever you need, but you must install the 

imaging software that is included in the master image. This is not always rational. 

1. Configure the master system. 

2. Install a TBR series product in the master system. 

3. Run a job to backup the system partition or all hard disks of your master computer. Please 

refer to the corresponding manual for detailed steps.



 

6 Manual Deployment 

A deployment template is a set of configuration parameters of the deployment operation. This 

includes: 

1. A path to the master image 

2. Settings to be applied to the deployed systems (DNS names, user accounts etc.) 

3. Operations to be performed on the deployed systems (transfer files, execute applications, 

shut down, restart) 

6.1 Why save templates? 

Deployment templates can be saved on the Farstone TotalDeploy Console. Once you save a 

deployment template, you may use it again in the future. When setting up a manual 

deployment, simply select a template and start the deployment. Otherwise, you will have to 

configure the above parameters while setting up the deployment operation. 

6.2 Creating templates 

1. Enter the Farstone TotalDeploy Console 

2. Click Start deployment on the left panel 



 
3. Select the target clients 



 

Further sections of this chapter tell you how to use the Create Deployment Template Wizard. 

6.2.1 Master image selection 
Specify 

- the master image 

- the user name and password for the network shared folder if the image is on the 

network.  

The best practice is to map the shared folder as a local drive (Windows Explorer -> Tools -> 

Map Network Drive.) 



 
Farstone TotalDeploy Console can deploy images located… 

- in network shared folders 

- on the deploy console internal hard drive 

- on USB and FireWire (IEEE-1394) storage devices (hard drives, flash drives) attached 

to the deploy console 

- on DVD+R/RW, DVD-R/RW, CD-R/RW loaded in the deploy console media drive 

The best practice is keeping images on the deploy console hard drive. This minimizes network 

traffic during deployment. 

The image created on removable or detachable media must fit onto one media disk. To deploy 

an image spread on several CDs, DVDs or other media, copy all parts of the image to the same 

folder on the deploy console or on a network share. 

 

6.2.2 Disk/partition selection 
Specify: 

- The disk to deploy. (Multiple disk selection isn’t supported in this version.) 

- The disk partitions to deploy, if the image of the selected disk contains multiple partitions.  



 

By default, the system partition and active primary partition are checked. In general, the 

system partition and active primary partition is the same partition aside from the Windows 7 

OS. 

If you deploy one partition, it is assumed that the target disk has partitions and you will have to 

select the target partition to deploy over it. Other partitions will be cleared.  

The Master Boot Record (MBR) is always deployed from the image. 

If your operating system and its loader reside on different partitions, always include both 

partitions in the image. The partitions must also be deployed together; otherwise, there is a 

high risk that the operating system will not start. 

6.2.3 Target disk and partition selection 
Select the target disk for deployment. By default, the image will be deployed to the hard disk, 

which is specified in BIOS as number 1 (0Х80). 



 

6.2.4 User accounts 
[OPTIONAL] Specify local user accounts that you want to create on the target computers in 

addition to the accounts that exist in the master system. 

Users can be added to the Administrators, Power Users or Users groups. Here you have an 

opportunity to add a unified administrator account to all the systems, if needed. The Edit and 

Delete buttons are provided to change the accounts you typed in. 



 

The password complexity must meet the password policy set for the master computer. To view 

or edit the password policy on the master computer: 

1. Run Microsoft Management Console (MMC) 

2. File -> Open -> %windir%\system32\secpol.msc 

3. Select Account Policies\Password Policy. 

6.2.5 Computer names and domain/workgroup 
[OPTIONAL] Specify DNS names and domain or workgroup membership of the target 

computers. If you have selected the domain membership, you will later be asked for the 

domain administrator’s name and password.  



 

6.2.6 Network settings 
Configure the Internet Protocol (IP) settings for the target computers. You have the option to 

preserve the master system network settings, obtain IP addresses automatically from DHCP 

server or to specify a range of static IP’s, subnet mask, and default gateway in case your 

network does not have DHCP capability. 

[OPTIONAL] If you have not selected to preserve the master system settings, specify DNS 

properties as well. 



 

6.2.7 Security identifiers 
Farstone TotalDeploy can generate unique security identifiers (SIDs) for the target computers. 

This option is automatically enabled. The SID can remain unchanged if there is no computer 

with the same SID in the same workgroup or domain. Also, it is recommended not to change 

the SID if the image is deployed on the same computer where the image was taken from. 



 

6.2.8 Transferring files 
[OPTIONAL] Select files to be transferred to all target computers after deployment (such as 

installation files). The files must be located on a network share. Check Execute file if you want 

to execute the files after deployment. 



 

6.2.9 Executing applications 
[OPTIONAL] You can specify service applications (from the master system image) to execute 

on the target computers after deployment. 

6.2.10 ADD Custom Hard­disk Driver 
[OPTIONAL] If the Master image is deployed to dissimilar target computers, you may need to 

inject corresponding hard disk drives into these computers. 



 

6.2.11 Options After Deployment 
The preset function is to Shutdown. 

Choose whether you would like to shut down, restart or do no operation to the target computer 

after the deployment and all associated operations, scheduled in this wizard (transferring files, 

executing applications) are completed. 

6.2.12 Summary Window 
Check your settings in the summary window and check “Save deployment setting”. 



 



 

7 Template Deployment   

All saved templates generated during manual deployment are saved in a given folder, which 

can be changed by clicking “Set Template Path” on the Tool tab page. You may also do a 

deployment job by selecting an existing template (if it is not a manual deployment).  

“Template Deployment” is based on the saved template, but the target computers are all 

currently connected computers. 

7.1 Template selection 

1. Template Selection. Select a template from all saved deployment templates. 

 

2. Template Summary information. Display summary information of the saved template. 



 

3. Starting deployment. The selected template will be deployed to all connected target 
computers. 
 



 

8 Tools 

8.1 Export Backup Agent 

1. Click “export backup agent” in the tools interface. 

2. Select location for ISO image files to save. 

The ISO image can be directly burned onto CD/DVD in Windows 7. 

 

 

8.2 Export PXE Files 

Export the PXE image to restore system without using the Bootable Rescue Disk.  

1. Click on the Tools tab, and select Export PXE Image. 

2. Enter the destination path where you want to save the exported files and click OK, or 

Browse the destination path locally or remotely and click Next. 

3. After successful exporting PXE files, click OK to return to the main console. 

For detailed information about how to set up a PXE Server and boot targets into Farstone 

Pre-OS, please refer to “Appendix 1 Setting up a computer to boot from PXE”. 

8.3 Export bootable agent 

To save the bootable ISO image, you can do as follows: 

1. Click export client Agent. 



2. Click browse button to select a path to save the bootable ISO image. 

3. Click OK. 

 

8.4 Checking image 

To be assured that a master image is not damaged, you can check its integrity. 

1. Select Check Image under the Tools page. 

2. Follow the wizard’s instructions to select the image. 



 

3. Click Start button to start checking process.  



 

The checking operation starts. You can stop the operation by clicking Cancel. 
After the check is complete, the program will show the results. 

 

8.5 View log   

Click View log in Tools tag page to see all logs about up-to-date log information of your 

deployment jobs. 



 

 

8.6 Set template path 

All saved templates will be saved to a default folder under the installation folder, but you 
can change the path through the “Set template path” function. 



 

 



 

9 Setting up a computer to boot from PXE 

9.1 Exporting PXE files 

(1) Create a folder on your desired location. For example, you may use “PXE”, like in 

the screenshot below. 

(2) Select “Export PXE files” from Tools Tab page, and Browse to “PXE” folder. 

 



(3) Once PXE image is exported to your selected location, you will find a “Boot” folder 

which contains all related boot files. 

 

 

9.2 Setting up a PXE Server in Windows? 

(1) Download free TFTPD32 from website: http://tftpd32.jounin.net/ , and install it on the 

machine where the PXE image is exported to. 

(2) Set “Current Directory” to the same folder where you exported the PXE image 

to:  

(3) Configure TFTPD32’s  DHCP Server 

Server interfaces: It shows IP address for current system. In this case, it uses 
192.168.142.129 
IP pool starting address: It shows the initial IP address that was assigned by DHCP. 
Be sure this IP is in the same WAN as your local network. In this case, it started from 
“200”. 

Boot File: Please type in boot\pxeboot.com 

http://tftpd32.jounin.net/


Fill in rest of columns with the appropriate information. Once you are done, click Save. 

 

9.3 Setting a computer to boot from PXE server 

The BIOS must first be configured so that the network interface card is either the first bootable 

device or prior to the Hard Drive device boot. The example below shows one of the reasonable 

BIOS configurations. If you don’t insert bootable media, the computer will boot from the 

network. 

 



Setting up the BIOS (example) for network boot 
In some BIOS versions, you must save changes to BIOS after enabling the network interface 

card so the card will appear in the list of boot devices. 

If the hardware has multiple network interface cards, make sure all of the cards are supported 

by the BIOS that has the network cable plugged in. 

After setting configuration and rebooting the computer, you’ll see the networking-booting 

screens below. 

 

 

At the same time, on the PXE server, you will see the picture below. 

 



After the deployment, if you do not want the target computers to boot into the 
Farstone Pre-OS again, stop all PXE-related services, like the program “Tftpd32”. 



 

10 Appendix  Terminology 

The following table lists the common terms and descriptions used in this document. 

Master system The system to be deployed. 

Master image (Image) A file that contains the master system in a packaged form. The file 
has a “.sco” extension. 
Online imaging Taking an image while the master system is in a production state (the 
operating system is running on the master computer). 

Offline imaging Taking an image while the master computer is booted into Farstone Pre-OS 
environment. 

Deployment Transferring the operating system (OS), applications and data from the master 
image file to a physical hard disk. In most cases, deployment is performed by multicasting the 

image through the network. 

Target disk The physical disk to be deployed to (an internal hard disk of the target 
computer.) 

Target computer (Target) The hardware to be deployed to. 

Deployment template (Template) Configuration parameters of the deployment 
operation: 

1. Path to the master image 

2. The operation mode (multicast, how to handle the target disk free space etc.) 

3. Settings to be applied to the deployed systems (DNS names, user accounts etc.) 

4. Operations to be performed on the deployed systems (transfer files, execute 

applications, shut down, restart) 

Once you save a deployment template, you can use it in the future. 

Administrator The person who has rights to manage Farstone TotalDeploy infrastructure. 

Custom deployment mode The mode when deployment can be initiated on the target side 
only. 
User The person on the target side who initiates the custom deployment. This term relates to 
the custom deployment mode only. 
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